Chapter 16 )
GPS Forensics Creck o

Learning Objectives
The objectives of this chapter are to:

* Understand the principles of GPS

* Understand fundamentals of GPS Forensics

* Know how to use GPS data analysis techniques and mapping technology
* Know how to recover track logs from GPS devices

* Become familiar with the tools necessary to examine GPS devices

The law enforcement community has seen an increasing use of Global Positioning
System (GPS) device as an instrument of crime, or as a “witness device”, due to a
feature that autonomously collects and logs positional data during the crime. GPS
devices are becoming an integral part of many investigations.

In CSI: Miami (Crime Scene Investigation: Miami)—‘Time Bomb’, the detective
is able to assemble a GPS device using a GPS chip that was discovered on a murder
victim’s body. The device was then used to backtrack along the path of the victim’s
vehicle, successfully discovering where this vehicle came from. This information
proves to be crucial in identifying the murderer. While this particular story is fake, it
is not difficult to imagine such an event occurring in the real world. GPS devices
aren’t just useful for digital investigation; however, they can provide incriminating
evidence too. Being able to prove that a device was at a specific location at a specific
date and time could be just as valuable to an investigation as a smoking gun.

GPS device forensics can provide crucial evidence in criminal and civil cases.
Some of our modern day GPS devices include portable GPS devices as well as auto,
aviation and marine devices.
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In this chapter we will introduce the fundamental basics and techniques of GPS
forensics. The techniques we introduce have a wide application in GPS data analysis,
even though we will only be discussing them using Garmin GPS device as an
example. Finally, we will introduce the tools used for forensic analysis of GPS
devices and applications.

16.1 The GPS System

The GPS is a worldwide radio-navigation system formed from a constellation of
27 satellites (24 in operation and three extras in case one fails) and their ground
stations that manage the satellites. There are a number of applications of GPS; two of
the most popular applications are GPS Tracking and GPS Navigation. Both
operate on the principle of trilateration using satellites. The GPS device communi-
cates with a satellite using high-frequency, low-power radio signals that travel from
the satellite to the device. By precisely measuring the travel time of the signal, the
device can precisely calculate how far away it is from the satellite; RADAR uses this
same principle to detect distant objects.

The theory behind it is very simple. For simplicity, assume that we have precise
clocks for both satellites and GPS devices. A satellite constantly broadcasts signals
to GPS devices, and the information in a signal contains the identifiable information
of the satellite, the current location, and the current date and time (or the time the
signal is sent). Upon receipt of a signal, the GPS device calculates the difference
between the time the signal is sent and the time it is received. Then it knows how
long the signal takes to reach the receiver from the satellite. Since we know a radio
signal travels at the speed of light (186,000 miles/s), we can obtain the distance
between the satellite and the GPS device by multiplying the signal travel time by the
speed of light (Fig. 16.1).

The GPS works based on trilateration from satellites, as shown in Fig. 16.2.
When a GPS device performs this distance calculation with one satellite, it can only

distance from a satellite
using signal travel time
distance = speed of
light x signal travel time

Fig. 16.1 Calculate N‘
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Fig. 16.2 GPS trilateration
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conclude that it is somewhere on the surface of an imaginary sphere around the
satellite, such that the sphere’s radius is the calculated distance. Although very little
of this sphere intersects with Earth’s surface, the possibilities are still far too great.
By performing the calculation with a second satellite, however, a second sphere can
be created, and the device lies somewhere on the circle of intersection between the
two spheres. A third satellite measurement will narrow the possibilities down to just
two points where all three spheres intersect. In most instances, one of these points
will not lie on the Earth’s surface. As a result, GPS devices typically search for four
or more satellites in order to improve the accuracy. For a variety of reasons, GPS
devices could fail. For example, while driving through a tunnel or in indoor
underground parking lots, GPS devices do not work properly because the satellite
signals cannot penetrate walls or other obstacles. It requires a direct line to GPS
receivers [1].

Global Positioning System, or GPS for short, device forensics can provide crucial
evidence in criminal and civil cases. Some of our modern GPS devices include
personal GPS devices as well as auto, aviation and marine devices. Also, GPS
applications such as Google Maps become prevalent in today’s smartphone. As
shown in Fig. 16.3, a typical GPS device today has the following logical structure
and consists of:

¢GPS receiver: It is an electronic unit that is able to determine the user’s current
position through analyzing the radio waves sent by GPS satellites.

 Built-in map: It provides map view to the user by mapping the position calculated
according to the signals broadcasted by the satellites to a physical location in the
world. Also, it can determine the velocity of the user according to its motion.
Further, it can derive the driving behavior of drivers.

* Network connectivity: Nowadays GPS devices are equipped with various wire-
less technologies. For example, Bluetooth becomes very popular in today’s
smartphone. It allows GPS devices to be paired with the user’s phone. As a
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Fig. 16.3 GPS device structure

result, GPS devices can be connected to the Internet, using a wide variety of
cloud services, for example, automated map updating. However, it is optional to
have it.

There have been plenty of portable GPS devices, but Garmin and TomTom units
are by far the most popular ones used by the public. Similarly, with the popularity of
smartphones, we have witnessed an increase in the installation of GPS Navigation
Apps on smartphones. However, many in-vehicle communications and entertain-
ment system such as Ford Sync (stylized Ford SYNC) also contains built-in GPS
navigation functionality, offering drivers’ satellite navigation. Nevertheless, the
wide variety of available GPS devices create many challenges for investigators;
with so many different models available, it becomes difficult to acquire and analyze
the evidence in them, as each one must be treated differently. Furthermore, modern
GPS devices contain much more than navigational information. They may contain
data commonly found in cell phones. Investigators may also find audio, video, and
text based files like MS Word or PDF documents. The focus of this chapter will be
on Garmin niivi devices, Garmin niivi 1350 in particular, but the general process is
also applicable for other device types and models.

Some important concepts and definitions that will be used throughout this chapter
are presented in Table 16.1 for reference.
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Table 16.1 Definitions and common concepts

Coordinate | The coordinates are numbers representing geographic locations on the earth, where

one number (e.g., elevation) represents vertical position and two or three of the
numbers (e.g., Latitude and longitude) represent horizontal position [2]

Waypoint | Waypoints are geographic locations defined by a GPS device user using their

coordinates or addresses, or some other Point of Interest (POI) so that they will be
travelled through

Destination | A destination is a geographic location defined by a GPS device user using their

coordinates or addresses. It is a location the user wants to arrive at

Track A history of where and when GPS device users have been. A track consists of

many track points or geographic locations where GPS device users have been
travelling through

Route A route is a path from the starting point (by default, the current location) of a trip to

the destination defined by the user

16.2 GPS Evidentiary Data

Today’s GPS devices contain plenty of data which are of interest to forensic
investigators. There are many types of valuable evidentiary data which may be
recovered from GPS devices depending on the manufacturer and model [3].

Track Logs

Trackpoints

Waypoints

Routes

Stored location, including Home and Favourite locations

Recent destinations: The addresses of the trips that GPS device users have made.
Paired device history: History of all devices (e.g., mobile phone) connected to
GPS devices via Bluetooth.

Videos, Photos, Audio

Call history, contact phone numbers and SMS messages: Call history, contact
phone numbers and SMS messages from the connected phone.

16.3 Case Study

Next, we will use a case study as an example of how to conduct a GPS device
forensic investigation. Specifically, we will show how to extract track logs from
Garmin niivi 1350.
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Fig. 16.4 Garmin
niivi 1350

16.3.1 Experiment Setup

GPS device:
e Garmin niivi 1350 (Fig. 16.4)
Software:

* FTK imager (version 3.4.2.2) [4]
e USBtrace (version 5.9) [5]
* Google Earth [6]

16.3.2 Basic Precautions and Procedures

Care should be taken when handling an evidence, like the GPS device obtained from
the suspect. It is essential to make sure that the data doesn’t get tampered in any way
when the device is connected to the investigator’s computer. Garmin niivi 1350
provides USB port for computer connection. While Garmin niivi 1350 is connected
to your computer, Windows will recognize it as a “Mass storage device”. Because
any data that is written into the device by the external unit (in this case the
investigator’s computer) will only complicate the matter when it comes to the
validity of the evidence. So, it is essential that the computer used by the investigator
doesn’t have any drivers meant for the GPS device and that the computer is not
connected to the Internet, in order to prevent the computer OS from automatically
downloading the drivers. It may also be imperative to use USB traffic sniffer
software to monitor the traffic between the GPS device. Here, the computer is
required. It will be required to keep a log of the traffic between the computer and
the GPS device that is being investigated. One such example of a USB traffic sniffer
software is USBtrace [5] from SysNucleus, as shown in Fig. 16.5. It is quintessential
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Fig. 16.5 A screenshot of SysNucleus USBTrace which is used for monitoring the traffic between
the Garmin nuvi 1350 and the desktop computer running Win 8.1. The Garmin device is connected
to the USB port of the desktop computer

to have a write blocker in place to be doubly sure that the computer doesn’t write
anything on to the GPS device under investigation.

It is absolutely essential to make a backup copy of the GPS device in question,
which is the evidence obtained from the suspect. One such tool that can be used for
backing up the device is FTK imager [4] from AccessData, as shown in Fig. 16.6.

All the forensics associated with GPS should be conducted in a place where the
GPS device won’t be able to contact the satellites, for example, a closed basement or
the unit must be in Faraday bag. If not, it leads to a situation where there may be new
entries/records on the device after it is confiscated from the suspect. This scenario
can be detrimental in accepting the device as an evidence. The information that is
most valuable to an investigator who looks for evidence, are files that carry time
stamped information about the locations that the GPS unit was at.

16.3.3 GPS Exchange Format (GPX)

The GPS exchange format (GPX) is a light-weight XML data format for the
interchange of GPS data (waypoints, routes, and tracks) between applications and
web services on the Internet [7]. GPX is designed to be the standard XML format for
recording GPS data and exchanging GPS data between applications (and GPS
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<?xml version="1.0" encoding="UTF-8" standalone="no" 7> ~
- =gpx xmins="http:/ /www.topografix.com/GPX/1/1"
amins: gpoc="http:/ /www.garmin.com/xmilschemas/GpxExtensions/v3"
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Fig. 16.6 A screenshot of AccessData FTK Imager ver 3.4.2.2. An image of the original Garmin
nuvi 1350 is created and the image is opened in AccessData FTK to do the analysis. It has features
to view or export a file from the image

devices). It can describe even complex objects that are geographic in nature. It is
designed to grow overtime. As GPX is an open standard, no fee or licensing is
involved.

Some of the significance used items in Garmin GPX files are Waypoint, Route,
Track Point and Track log. The ones that the user can interact with are Waypoint and
Route. On the system level, there are Track Point and Track log.

16.3.3.1 Waypoint

The user can store information in Garmin niivi 1350, for example, by defining
waypoints. A waypoint in this case is a location on earth the user stored in the
GPS. Mostly, waypoints contain address book as entries. Existence of waypoint
alone doesn’t mean that the user was at that particular location. Waypoint could be a
location that the user entered that he/she wanted to navigate to, in future. It could also
be a location stored by the user where he/she was physically present.
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Example for a Waypoint may look as follows:
<wpt lat="33.762918" lon="-118.196241">

<ele>-0.11</ele>

<name>Long Beach Aquarium of the Pcf</name>
<desc>100 Aquarium Way Long Beach, CA 9080</desc>
<sym>Waypoint</sym>

<extensions>

<gpxx:WaypointExtension>
<gpxx:Categories>
<gpxx:Category>Attractions</gpxx:Category>

</gpxx:Categories>
<gpxx:Address>

<gpxx:StreetAddress>100 Aquarium Way</gpxx:
StreetAddress>

<gpxx:City>Long Beach</gpxx:City>
<gpxx:State>CA</gpxx:State>
<gpxx:PostalCode>90802</gpxx:Postal Code>

</gpxx:Address>
<gpxx:PhoneNumber>1 5621253400</gpxx:PhoneNumber>

</gpxx:WaypointExtension>
</extensions>
</wpt>

As Waypoints are user entries, it may not be consistent. For example, see the
waypoint entry above and the one given below:

<wpt lat="41.991357" lon="-72.584978">

<ele>53.72</ele>

<name>Red Roof Inn</name>
<sym>Waypoint</sym>
<extensions>

<gpxx:WaypointExtension>
<gpxx:Categories>

<gpxx:Category>Map Points and Coordinates</
gpxx:Category>

</gpxx:Categories>
<gpxx:Address>
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<gpxx:StreetAddress>N 41°59.481' W(072°35.099'</
gpxx:StreetAddress>

</gpxx:Address>
</gpxx:WaypointExtension>
</extensions>

</wpt>

16.3.3.2 Route

If a user wants to navigate a series of waypoints in a specific order, then it is a route.
In other words, a route is defined by the user. After reaching a waypoint, the unit
guides the user to the next waypoint.

16.3.3.3 Track Point

The track point shows the location recorded by the GPS regarding where it was,
provided the unit was turned on and it had established satellite links. This record
carries the timestamp, latitude, longitude, and elevation. The track point extension
carries information about the speed as well. The track points are generated automat-
ically by the GPS unit and the user cannot define or change what gets generated.
Again, the applications within the GPS decide on the generation frequency of these
track point records.

Note that there are no settings in Garmin niivi 1350 which can dictate the terms of
the generated frequency of track points or to turn the recording off. This doesn’t
mean that such features are non-existent for other models.

For example, given below is an example for a track point.

<trkpt lat="43.658288" lon="-79.352451">

<ele>78.48</ele>
<time>2015-01-15T23:35:46Z</time>
<extensions>

<gpxtpx:TrackPointExtension>

<gpxtpx:speed>8.24</gpxtpx:speed>
<gpxtpx:course>254.12</gpxtpx:course>

</gpxtpx:TrackPointExtension>
</extensions>

</trkpt>
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Fig. 16.7 The difference
between route and track
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16.3.3.4 Track Log

This is the complete list of track points that is created and stored by the unit when the
GPS device is locked onto a satellite signal and moving. It is the electronic
equivalent of laying down a “breadcrumb trail” to mark the path that has been
traveled. This helps the user to retrace the steps. In other words, it allows the user to
perform a track back.

The difference between track and route is that route is a suggestion on where the
user may go in future. Track, on the other hand, is a record of where the user has
been. Track has a good number of track points to generate the fine details of the path.
As shown in Fig. 16.7 [8]. Each track point may have a timestamp as a location and
time is being recorded. On the other hand the route points are unlikely to have
timestamps. Moreover the distance between two track points are on an average
50 meters or less. Nevertheless, the route points may be apart by a kilometer or more.

16.3.3.5 Track Segment

Track is a collection of track points, listed in the order they are generated. This list
can be broken down or divided into two or more track segments that are listed in
sequential order. Following is an example of a track segment constituted of multiple
track points.
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<trkseg>

<trkpt>
<trkpt>
<trkpt> ... </trkpt>

</trkseg>

</trkpt>
</trkpt>

16  GPS Forensics

The track points and tracks are a treasure mine for the investigator. It doesn’t
mean we should limit ourselves to just that. Instead, we should explore more to see
what else may be there.

16.3.4 GPX Files

The GPX files which carry the track point information are found in folder \GPX and
the archived files are found in \GPX\Archive folder. The latest one is in \GPX folder
and it is called “Current.gpx”. It contains most recent tracks and carries favorites as
well. The archived ones have numeric file names such as “19.gpx” to “38.gpx”. The
files that are in ‘“\GPX\Archive” folder have past information regarding the track,
time, location etc. (Table 16.2).

Table 16.2 Example list of ‘gpx’ files found in Garmin niivi 1350

Filename Full path File size (Bytes) | Created Modified

Current.gpx | \GPX\Current.gpx 2,083,450 07/30/2011 15:06 | 12/11/2016 13:00
19.gpx \GPX\Archive\19.gpx | 2,879,238 07/8/2012 14:00 | 07/15/2012 17:41
20.gpx \GPX\Archive\20.gpx | 2,949,422 07/15/2012 17:41 | 08/10/2012 24:17
21.gpx \GPX\Archive\21.gpx | 2,333,630 08/10/2012 24:17 | 08/10/2012 24:18
22.gpx \GPX\Archive\22.gpx | 3,129,413 08/10/2012 24:18 | 10/08/2012 13:27
23.gpx \GPX\Archive\23.gpx 958,394 10/08/2012 13:27 | 03/14/2013 10:41
24.gpx \GPX\Archive\24.gpx | 1,053,696 03/14/2013 10:41 | 08/22/2013 20:45
25.gpx \GPX\Archive\25.gpx | 2,166,664 08/22/2013 20:45 | 08/22/2013 20:47
26.gpx \GPX\Archive\26.gpx | 2,712,169 08/22/2013 20:47 | 08/24/2013 24:44
27.gpx \GPX\Archive\27.gpx | 2,742,380 08/24/2013 24:44 | 08/25/2013 05:17
28.gpx \GPX\Archive\28.gpx | 1,107,530 08/25/2013 05:17 | 09/01/2013 06:42
29.gpx \GPX\Archive\29.gpx | 2,095,540 11/17/2015 13:48 | 11/17/2015 11:49
30.gpx \GPX\Archive\30.gpx | 3,015,182 11/17/2015 11:49 | 12/02/2015 14:55
31.gpx \GPX\Archive\31.gpx | 2,073,189 12/02/2015 14:55 | 12/02/2015 14:55
32.gpx \GPX\Archive\32.gpx | 1,886,340 12/02/2015 14:55 | 12/02/2015 14:56
33.gpx \GPX\Archive\33.gpx | 1,888,595 12/02/2015 14:56 | 12/02/2015 15:58
34.gpx \GPX\Archive\34.gpx | 1,859,629 12/02/2015 15:58 | 12/02/2015 14:59
35.gpx \GPX\Archive\35.gpx | 2,188,914 05/12/2016 14:11 | 05/12/2016 14:14
36.gpx \GPX\Archive\36.gpx | 2,123,463 05/12/2016 14:14 | 05/12/2016 14:16
37.gpx \GPX\Archive\37.gpx | 1,995,567 05/12/2016 14:16 | 05/12/2016 14:18
38.gpx \GPX\Archive\38.gpx 53,875 05/12/2016 14:18 | 05/12/2016 14:18
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16.3.5 Extraction of Waypoints and Trackpoints

As mentioned earlier the Garmin niivi’s current waypoints, tracks, and routes are
stored in the file “Current.gpx” which is created by the unit. It’s worthy pointing out
that Garmin calls waypoints as Favorites. To view them, press “Where To?” on the
home screen of the GPS (Fig. 16.8).

In the next screen, press on “Favorites” (Fig. 16.9).

Then, press on “All Favorites” (Fig. 16.10).

And, it will display the favorites as follows (Fig. 16.11).

Fig. 16.8 Home screen

Where To? View Map
Volume Tools
Fig. 16.9 The ‘Where to?’
Address Go Home Points of Interest
Qul W
Recently Found Favorites Intersection
* Near \ 4
Fig. 16.10 Favorites .
All Favorites
Address
Attractions
Food

>, A 4
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16.3.6 How to Display the Tracks on a Map

Getting the favorites, address stored, etc. is great. But from a crime stand point of
view, it is essential to prove that the device actually went to a location on the
day/time where the actual crime was committed.

So, it is essential to display the data on a map, with all the other parameters. There
are a lot of applications and websites that are capable of displaying the track. We use
Google Earth [6]. It can be downloaded from http://www.google.com/earth/down
load/ge/agree.html

Once the application is installed, run it. The opening screen will look as follows
(Fig. 16.12):

Let us make an assumption that there was some crime committed in Durham
Forest, Uxbridge, Ontario on 21 May 2012 during the day time. Say the GPS device
obtained from the suspect still carries the data. After going through the whole
archives, say that the relevant data is in file “17.gpx”.

On Google Earth, from the horizontal menu bar, select “File” and click on
“Open”. Make sure the selection is for GPS (*.gpx...). Browse the folder in
which the “17.gpx” file is located (Fig. 16.13).

Under GPS devices, expand “Tracks”, as shown in Fig. 16.14.

Expanded track will look like Fig. 16.15.

As we are specifically only interested in the details pertaining to 21 May 2012, we
can deselect all the others. By selecting the module we want and clicking on “Play
Tour” button (indicated in red circle in Fig. 16.16), we can get an overview of the
movements.


http://www.google.com/earth/download/ge/agree.html
http://www.google.com/earth/download/ge/agree.html
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Fig. 16.12 Google earth
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Review Questions

. What are the two most popular applications for GPS?

. What are the two most popular brands of GPS systems for the public?

. List four types of evidence that may be found within a GPS device.

. In GPS navigation terms, what are the differences between Route and Track?

. What GPS tools do you use regularly, and when has GPS not worked for you?
Tell us in the comments.

DN AW =

16.4 Practice Exercise

The objective of this exercise is to practice GPS Forensics to reconstruct location,
waypoint, and speed data.

16.4.1 Setting Up Practical Exercise Environment

For this exercise, assume a Garmin GPS devices can be found by the reader. Also,
USB to Mini-USB Cable is needed to connect the GPS device to the computer. If
not, you can use the GPS image provided in the book. In the zipped file which
contains all the data files used in the book, you will find a chl16 subfolder that
contains all the files for this exercise. Make sure you copy and paste these files into a
particular folder on your hard disk.

1. Download the AccessData’s FTK Imager from the following website: http://
www.accessdata.com/support/product-downloads

2. Run the downloaded installer and follow the on-screen instructions to finish the
installation with default settings.

3. Download the Google Earth from the following website: https://earth.google.
com/download-earth.html

Note: both of Google Earth and Google Earth Pro are free for public now, so

you can download either of them for GPS investigation.

4. Run the downloaded installer and follow the on-screen instructions to finish the
installation with default settings.

16.4.2 Exercises

Part A: Acquire a Forensic Image of a Garmin niivi 1350 Device with FTK
Imager

Note that if you don’t have any Garmin GPS devices, you can skip this part and
proceed to next exercise to analyze Garmin GPS Image provided.


http://www.accessdata.com/support/product-downloads
http://www.accessdata.com/support/product-downloads
https://earth.google.com/download-earth.html
https://earth.google.com/download-earth.html
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1. Launch the FTK Imager

He Vew Mode Hep

adeaaGUEBsa~mad D00 SR .
(Custom Content Sources < |[File List x
Evidence:Fie System PathFie | Options Name | Size | Type | Date Modified |

W

Hex Value Int... mﬂ.uncenle...l

For User Guide, press F1 | a

2. Click Tools > Create Disk Image.

3. On Select Source page, choose the Source Evidence Type you are using. In the
present exercise, you will select “Physical Drive” since we are creating an image
of the internal storage of a GPS device. Then, click on Next to continue.

~ Please Select the Source Evidence Type
© Bsea b

 Logical Drive

€ Image File

€ Contents of a Folder

fogical filedavel analysis only; excludes deleted, unallocated, etc.)
 Femico Device (multiple CD/DVD)

4. Select the driver to be imaged and click Finish to continue. For our scenario
example, we will select “\cr.\PhysicalDrivel”. Then, click on Finish to continue.
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Source Drive Selecti

Please select from the following avadable drives:
|\\\PHYS¢CALDFIN‘E0 - SAMSUNG S5D PM851 2.5 7mm 256G ;]

\\\PHYSICALDRIVED - SAMSUNG SSD PM851 2.5 7mm 256GB [2|
WAPHYSICALDRIVET - Gammin nuvi Bash USB Device [1GB USB]

5. On Create Image page, click Add to select where you want to save the image.

<,
ource

[ \\\privsICALDRIVE L

Starting Evidence Number | 1

- Image Destination(s)

[V Verify mages after they are reated [~ Precalculate Progress Statistics
[T Create drectory lstings of all fles in the image after they are geated

6. Continue through the prompts and select Image Type (for example, Raw (dd)
which just contains the data from the GPS device). Enter Evidence Item Infor-
mation (Case Number, Evidence Number, Unique Description, Examiner and
Notes), and select both the image destination folder and the image filename.

7. Once the image destination setup is complete, you can either click Add to add
another destination or click Start to begin the acquisition.
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~

Add Overfiow Locaton |

¥ Verify images after they are created [ Precalaate Progress Statistics
[~ Create directory listings of all files in the image after they are created

Start | Cancel |

8. Once completed, the Drive/Image Verify Results page will appear.

a8
Hame
Sector count

B MDS Hash
Computed hash
Report Hash
Verfy resuk

B SHA1 Hash
Computed hash
Report Hash
Verfy resuk Match

B Bad Sector List
Bad sector(s) No bad sectors found

Part B: Extract Track Logs from Garmin niivi 1350

The next step is to extract track logs from the Garmin niivi 1350 image we acquire.
The “.gpx” file is the key file for navigation in GPS forensics. As mentioned earlier
the folder \GPX contains the GPX files which carry the track point information.

1. Launch the FTK Imager and click File > Add Evidence Item to add the GPS
device image you acquire (or provided in the book) as an evidence item.



16.4 Practice Exercise 393

Vew Mode Heb

Add Evidence Rtem... R DB E=Eme e .

Add Al Attached Devices |Fi|?|.i5t x
Image Mougting... Name | size | Type | DateModified |

Bemove Evidence Rtem

Remove Al Evdence Items

Export Disk Image...

Export Logical Image (AD1)...

Add to Custom Content Image (ADL)
Crgate Custom Content Image (AD1)...
Decrypt ADL image...

Verfy Drive/Image...

Capfure Memory...

Obtain Protected Fles...

Detect EFS Encryption

Export Fles...

Export Fle Hash List...

Export Drectory Listing... =

g, GF Fole : ] A

2. Continue through the prompts and select the Source Evidence Type (“Image
File”), and select the acquired image file. Then, click Finish to add it as an
evidence.

Ele Vew Mode Heb
cdtoa @B om B DDE @R e .
M|Evidence Tree « |[Fite List %
- gpe-001.001 Name | Size | Type | Date Modified |
00000000 |EB 52 6D 68 &4 &F 73-66 73 00 00 02 02 07 00 |&X -mikdosfy:---«--- -~
00000020 |01 00 00 00 00 F& 00 00-20 00 40 00 00 00 00 00| -+-+ @+ Brovvr |
00000020 |34 2E 38 00 21 OE 00 00-00 00 00 00 02 wee =
00000030 01 00 0§ 00 00 00 00 00-00 00 00 00 00
00000040 |00 00 2% DC 21 BD E1 47-41 52 4D 49 4E
00000050 |20 20 46 41 54 33 32 20-20 20 OE 1F BE
00000060 |22 CO 74 0B 56 B4 OE BB-07 00 CD 10 SE
00000070 |E4 CD 16 CD 13 EB FE 54-68 69 73 20 63 73 20 6E |&1-1-#pThis s n
| Cursor pos = 03 log sec = 0
For User Guide, press F1 If ] a
R




394 16  GPS Forensics

3. Expand the Evidence Tree and Navigate into the folder \GPX (and its subfolder
Archive), and locate the GPX files from GPS devices.

Hame | Size | Type | Date Modified | A
| 18gpx 2812 Regulas File 152012 §ete—
| 15.gpuFileSlack 1 File Slack
Ele Vew Mode Heb _ Mgpx 2881 Regular File 102012 417
. ) =2 . & 1 Rl aa L 2gpxFileSlack 4 File Slack
@as ad-bs =8s0ne _l2lgpx 2278 Regular File B0 418
Evidence Tree « | File List L 21.gpuFileSlack 2 File Slack
=y gee-001.001 Hame | Rgpx 3057 Regulm File R2012 27
k8 GARMINFATIZ) 1. Archive | 22.gpaFileSlack 4 File Siack
B0 et q Current | 23gpn 936 Regulas File 31402013 241
W 1TIS000_ --CU“'W’ Stack | 23.gpuFileSlack 1 File Slack
B System g‘-”m’”:_ Ll 24gpx 1029 Regulsr File NN 12
D) Gamn e 24.gpu FileSlack 3 File Stack
: P gpxFibeSlack
— - ) GPE L Pesition.geuF: Cl2sgee 2116 RegulacFile 8232003124
|0 Archive .| 25.gpFileSlack 1 File Stack
‘!‘Sm _ 2gpx 2640 Regulas File 22013 bbk
FileSlack 4 File Slack
e | Fgpul v
1) Reperts
) Screenshat
1) System Volume Ifomaton.
O Ten
123 Veicke
10 Ve
1 hnslocated space] 000 | E 20 20 20 20 20 20 20-20 20 20 10 00 00 00 00]. e -
01000 00 00 00 05 00 00 00-00 OO 23 73 00 00 00 08| -+~ -- - ha-- -
020|2F 2E 20 20 20 20 20 20-20 20 20 10 00
03000 00 00 00 00 00 00 00-00 OO 00 00 00 O
04041 43 00 75 0O 72 00 72-00 65 00 OF 00 F:
050(74 00 ZE 0O 67 00 70 0O-TE 00 GO 00 00 v
Cursor pos = 0; dus = 357155; log sec = 2860848
For User Guide, press F1 % |

4. Transfer GPX files to your computer by right-clicking on the folder GPX, choose
Export Files from the options in the menu that appears, and select the destination
folder. In our example, we saved it under \Garmin.

Ee View Mode Heb
aascaddlBa ~m B 0D =Ee e,
x
£ ges-001.001 Name | size | Type | Date Modified |
E-lp GARMINFAT2Z) . Archive 4 Directory /122016 6:1:...
E":‘?.““!'?m || Current.gps 2035 Regularfile  12/11/2016 60...
é-?gs - || Current.gpxFileSlack 2 File Slack
8 Gamin ] Positicn.gpx 1 Regular File 12/11/2016 55...
bt | Positi iteSlack 4 File Stack
T Export Fles...
@ hel ] Export Fle Hash List...
ZEMB Export Logical Image (AD1)...
3 Re g3 Add to Custom Content Image (ADL)
-
- Tent
- Viehicle.
3 Voice
£ unalocated space]
GHOEZZ 20 20 20 20 20 20 20-20 -~
01000 00 00 00 05 00 00 00-00 |
020!2! 2E 20 20 20 20 20 20-20
030(00 00 00 00 00 00 00 00-00 00
oaoln 43 00 75 00 72 00 72-00 F2 6E £
050 |74 00 2E 00 &7 00 70 00-78 o0 Fr "
080 |43 55 52 52 45 4E 54 20-47 50 58 20 00 C2 98
070 |FE 3E 6F 46 05 00 01 90-8B 49 6A 73 7A CA 1F 00 [p>ef-----Ijszt =
Cursor pos = 0; cus = 357155; log sec = 2860848

‘mmmmmmwm | A
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Part C: Analyze Track Data from .gpx Files
In the following exercise you will analyze one GPX file, \GPX\Current.gpx, and
answer the following questions. In order to answer these questions properly, you will
perform statistical analysis of GPX Files. In doing so, you need to parse GPS track
data (tracks and waypoints) into a format accepted by a statistical analysis tool such
as Excel. You can either develop your own GPX file parser or use an open source
tool. There are many online tools for GPX file analysis. For example, you can use the
following tool named GPX Editor to analyze track data from GPX files https://
sourceforge.net/projects/gpxeditor/

It is strongly recommended that you design and develop your own GPX file
parsing and analysis tool for this exercise.

GPX Files Analysis Questions:

Q1. How many track points are stored in the file “Current.gpx”?

Q2. What are the latitude and longitude of the first track point stored in the file
“Current.gpx”?

Q3. How many waypoints are defined in the file “Current.gpx”?

Q4. What are the latitude and longitude of the first waypoint stored in the file
“Current.gpx”?

Q5. What is the total distance traveled by the car according to the “Current.gpx™?

Part D: View Track Logs in Google Earth
In the following exercise you will practice how to use Google Earth in your
investigations. It is particularly very useful for presentation to investigators, attor-
neys and in courtrooms.

Note that if your GPS device isn’t supported by Google Earth, you will need to
import GPS data as a .gpx or .loc file.

5. Launch the Google Earth Pro and Click File > Open.

6. Select GPX Files from the Open dialog box by navigating into the folder \Garmin
\GPX. Notice that the dialog has a combo box for selecting the file types, and you
have to select GPS file types including GPX.


https://sourceforge.net/projects/gpxeditor
https://sourceforge.net/projects/gpxeditor
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1 L « Local Disk (C)) » Garmin » GPX

Organize « MNew folder

L) Name

3¢ Favorites

B Desktop 4 Archive

v

¢

16  GPS Forensics

Search GPX

Date modified

8/31/2017 14PM  File folder

8 Downloads | L] Current.gpx

12/11/2016 1:00PM  GPX File

% Recent places | Position.gpx

&, Homegroup

™ This PC
_im Desktop
| Documents
8 Downloads
& Music
& Pictures
B Videos
i Local Disk (C:)

i Nahnd i B

File name: | Current.gpx

12/11/2016 12:58 ...  GPX File

>

v | Gps ( ".gpx ".loc *.mps ".gdb ".t v|

| Open || conc |

7. On Google Earth—GPS Data Import page, both Create KML Tracks and Adjust
altitudes to ground height options are enabled by default. Leave all the default
options in place and click on OK to continue.

Note that Keyhole Markup Language (KML) is a file format used to display
geographic data in Google Earth and Google Maps.

| Create KML Tracks
|| Create KML LineStrings

¥ Adjust altitudes to ground height
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8. Once a GPX file is imported into Google Earth, you can view the routes the
suspect has traveled by clicking the Play Tour button.

EBls Ed% Yww Jooh 5dd Help
¥ Search

Search

Get Directsons. History
¥ Places
¥ 71 My Places

» Y2 Sightsesing Tour

Detailed
[~ ¥/ 83 Temporary Places
track logs | - s &

N~

wkome

P E
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